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Introduction 
The VASS import process provides an alternative to manual data entry of student details and enrolments and 
can be used to create new Student Personal Details and Student VCE Program data for a year, or to amend 
existing Student Personal Details data. 

Only the home school is able to import student details or student programs, regardless of where the units are 
being assessed. 

Student personal details and program data is generally imported at the start of the academic school year, but 
can be imported throughout the year within the VCAA Important Administrative Dates. 

The import process is one of four VASS processes that are scheduled and then processed in the 
background. When a file is scheduled for import it is placed in a queue with files from other schools and will 
be processed in turn. It isn’t necessary to remain logged into VASS during this time. It is also possible to 
work in other areas of VASS as long as the data input does not involve the same group of students as the 
import. 

The import screen is accessible at any time to check on the progress of an import. 

Student personal details and student program data may be extracted from student management systems 
and imported into VASS as long as the files are correctly structured. These extracts may need to be modified 
before they are suitable for importing. 

The ability to import data is controlled by the Victorian Curriculum and Assessment Authority (VCAA). 

VASS Imports 

General Principles 
An import file can contain either student personal details or student programs for one or multiple year levels. 
Student personal details and student programs must be separate files as the required file structures are 
different. 

Data is converted and stored in uppercase on the VCAA database. 

Once a file has been scheduled, it is not possible to schedule another file with the same name until the status 
of the first file has moved from ‘Scheduled’ to ‘In Progress’. 

Errors in a file can be deemed ‘fatal or ‘non-fatal’. If the file contains fatal errors they prevent the processing 
of the file. Non-fatal errors do not prevent the processing of the file but will cause individual records in the file 
to be rejected (see Import Error Messages). 
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File Type 
VASS will only accept either a pipe or tab delimited text file containing the correct number of fields with valid 
data in each field. 

Other types of file formats (e.g. Excel, Word, Access) cannot be used as they contain hidden formatting which 
will cause the file to be rejected. 

• In a pipe or tab delimited text file the fields are separated by a single pipe (‘|’) or tab character. 

The pipe symbol is usually located on the same key as the backslash on the keyboard. 

• Correctly formatted files can be extracted from student management systems. 

Files can be created or altered using Excel and then saved as a text (Tab delimited)(*.txt) file. 

File Structure 
• Each of the required fields must be present in the file 

• If there is no data for a field and it is not a mandatory field then the field should be left empty and must 
not be deleted from the file 

• Import files can be altered using programs such as Excel or Access 

• An import file must not contain any blank rows 

• An import file must not contain a header row 

File Name 
The import file name or file path must not be over 30 characters in length, or contain any brackets or other 
special characters. Import file names that exceed this limit will result in an error. 

File Validation 
Each of the three import functions (Import Students, Amend Students and Import Programs) are two step 
processes: 

• The validation step checks the data for accuracy and completeness 

• The update step loads the data onto the VCAA database 

The validation step checks that the file matches the VASS file specifications: 

• A pipe or tab delimited text file with the forrect number of fields; 

• No fields exceed the maximum allowed character length; 

• The correct date format is used and the correct type of data is in each field 

If the file or any record in the file fails any one of these checks, then the validation process will stop at that 
point. The file will be rejected, given a ‘Bad File’ status, and no data wil be imported. 

On the completion of each phase of the import process an Import Report is produced. 
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Importing Student Personal Details 

General Principles 
Each student has a ‘year record’ for each year of enrolment. Once student personal details have been 
entered onto the VCAA database, it is not necessary to re-import this data every year as the VASS 
rollover function accessed via STUDENT ADMIN > Student Rollover can be used to create the new 
‘year record’ for consecutive years. 

Preparing The Import Students File 
The student personal details (Import Students) file structure is outlined in Table 1. The same file structure 
applies to both the Import Students and the Amend Students imports. 

• Each of the 24 fields must be present in the file. Where data is not available for a field (column) and it is 
not a mandatory field, then the field should be left empty but not omitted from the file. 

• There must be one record (row) for each student in the file, i.e. 60 students have 60 records (rows). 

• The file should not contain a header row. 

Student personal details are often extracted from student management systems, which may not be exported 
in the correct file format. For more information on how to check and amend these extracts, refer to Modifying 
Import Files in Excel. 

Additional Field Information 

Course Type (Column A) 

There are two possible course codes: 

• VCE – all students undertaking a VCE (including International Baccalaureate), VCM VM, VET or VPC 
program must have a course code of ‘VCE’. 

• PDO – Year 10 students entered onto VASS for the purposes of the On Track Project only (without a 
program) should have a course code of ‘PDO’ (Personal Details Only). 

External Student Identifier (Column E) 

The External Student Identifier field on VASS is the student identifier used by the school’s local student 
management system.  

The External Student Identifier is not a mandatory field but it is useful data to include in the Student 
Personal Details import as it is used along with the student’s name to match the student in a Student 
Program import or in an Amend Student import. 

Email (Column I) 

The email field is optional, however schools are recommended to enter student email addresses. The VCAA 
requires schools to enter a non-school email address for each student enrolled at senior secondary level, as 
these are used for results delivery and associated post-results services. 

https://www.vcaa.vic.edu.au/Footer/Pages/Copyright.aspx
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Student email addresses must be nominated by the student. Some schools prefer the school-issued email 
address be used; in this case, schools must ensure that the school-issed email address remains active up to 
the end of June in the year following graduation. 

Table 1 – The Import Students and Amend Students file structure 

Field Max Length Details 

Course Type (Column A) 3 characters Mandatory. Can be ‘VCE’ or ‘PDO’ 

DET School Code (Column B) 10 characters Mandatory if VCAA School Code is blank 

Can be found on the SCHOOL ADMIN > Modify School Details 
screen of VASS. 

 Excel Tip: Mark as text in Excel to preserve the leading zero 

VCAA School Code (Column C) 5 characters Mandatory if DET School Code is blank. 

Can be found on the SCHOOL ADMIN > Modify School Details 
screen of VASS. 

 Excel Tip: Mark as text in Excel to preserve the leading zero 

VCAA Student Number (Column D) 9 characters Optional. Alphanumeric. If entered it must be a valid VCAA 
Student Number 

External Student Identifier (Column E) 12 characters Optional. Alphanumeric. If included it can be used to identify 
the student instead of the VCAA Student Number in the 
programs & amend student import 

Family Name (Column F) 25 characters Mandatory. May only contain letters, hyphens, apostrophes 
and single spaces. Must contain at least one character 

First Name (Column G) 15 characters Mandatory. Can only contain letters, hyphens, apostrophes 
and single spaces. Must contain at least one character 

Second Name (Column H) 15 charaters Optional. Can only contain letters, hyphens, apostrophes and 
single spaces 

Email (Column I) 100 characters Optional – If entered: 
- Must contain no more than one "@" symbol. 
- Cannot include spaces or special characters (~, ], [, 

^, }, {, %, #, &, =, :, ;, ?, /, , <, >, ’, “). 
- Must contain a "." character after the"@".  
- Cannot end with a "." character. 

Address Line 1 (Column J) 25 characters Mandatory. The postal address to which end of year results are 
sent. Must contain at least one numeric character 

Address Line 2 (Column K) 25 characters Optional. This must not be the same as Address Line 1 

Suburb / Location (Column L) 30 characters Mandatory. Alphabetic only. The Australia Post approved 
format must be used: suburb name followed by the direction 

State / Country (Column M) 17 characters Optional if the postcode is a valid Australian postcode. If 
entered must be NSW, NT, QLD, SA, TAS, VIC or WA. Must 
be present if the postcode is **** 
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Field Max Length Details 

Postcode (Column N) 4 character Mandatory for Australian addresses. Use **** for overseas 
addresses 

Telephone Number (Column O) 15 characters Optional. May only contain numbers, hyphen and spaces. 

 Excel Tip: Mark as text in Excel to preserve any leading zeros 

Date of Birth (Column P) 10 characters Mandatory. Must contain numbers and forward slashes only & 
be in DD/MM/YYYY, D/MM/YYYY, DD/M/YYYY or D/M/YYYY 
format. 

 Excel Tip Mark as text in Excel to preserve format 

Gender (Column Q) 1 character Mandatory. Must be F, M or X 

Year level (Column R) 2 characters Mandatory. Must be in the range 7 -12 

Home Group (Column S) 8 characters Optional. Must be alphanumeric 

Previous Family Name (Column T) 25 characters Optional. Can only contain letters, hyphen, apostrophes and 
single spaces 

Previous First Name (Column U) 15 characters Optional. Can only contain letters, hyphen, apostrophes and 
single spaces 

Previous Second Name (Column V) 15 characters Optional. Can only contain letters, hyphen, apostrophes and 
single spaces 

General Declaration (Column W) 1 character Mandatory. If not “Y” then the student will not be imported 

Victorian Student Number (Column X) 9 characters Mandatory for all schools exclusing overseas and interstate 
providers. When entered, must be the student’s valid VSN 

 

 

 
Figure 1: Sample Student Details Import in Excel with a header row which must be deleted before the import 
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Creating New Student Records 
A new student record is created if there is no VCAA student number in the file and no existing student with the 
same family name, first name, gender and date of birth. If an import file contains data for a student who 
already has a year record created by the roll over process, then the record in the incoming file will be rejected. 

Amending Existing Records 
VCE, including VCE VM, and VPC certificates are posted to the student address entered in VASS, so these 
details must be correct. The Amend Students import is therefore a very useful tool. Students loaded onto 
VASS and subsequently rolled over from year to year can have their contact details updated from the school’s 
student management system (e.g. CASES21, Compass, Sentral, etc.) without the need to constantly make 
individual changes to both systems. 

Schools should ensure that the address details are correct prior to the last day for VCE Unit 3-4 sequences 
and VCE VET scored Unit 3-4 units of competency due date, as this is the last date by which amendments 
can be imported into VASS for Year 12 students. After this date, student details can only be updated 
manually. 

The Amend Students import matches a student using either their VCAA Student Number or External 
Student Identifier. 

• If a record does not exist for the student in the current year then the Amend Students import process will 
not insert one; this can only be done using Import Students. 

• If a record does not already exist for the student in the current year, then the incoming record will be rejected 
and an error will be written to the Import Report. 

Records will not be updated by an Amend Students import in the following circumstances: 

• There are too many differences (more than four changes) between the existing and incoming data. 

• The course type is changed. If the course type is different the overall record will still be updated, but a 
message will be written to the Import Report stating that the course code has not been changed. 

• The incoming file does not contain either a VCAA Student Number or the External Student Identifier for 
each student. 

• The External Student Identifier in the incoming file belongs to a different student on VASS. 

• The External Student Identifier in the incoming file is different to the student’s existing identifier already 
recorded on VASS. 

• Address Line 1 does not contain at least one numeric character. 

In these circumstances the record will be rejected and an error will be written to the Import Report. 
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The VASS Matching Process 
When students are added to the VCAA database they are matched against student records already on the 
VCAA database using four criteria: 

• Family Name 

• First Name 

• Date of Birth 

• Gender 

If an incoming student record exactly matches an existing record from the previous year at the home school, 
then a new year record will be created for the student and the existing data will be updated by the incoming 
record. 

If an incoming student record exactly matches a student who already has a record for the current year at a 
different school, then the incoming student record will be placed on the Import Hold Table. If the incoming 
student is not the existing student, then it will be necessary to contact VASS Operations. 

If an incoming student cannot be matched exactly against an existing student but matches on any 3 of the 4 
criteria to one or more students, then the incoming student will be placed on the Import Hold Table. 

• Students on the Import Hold Table have not been allocated a VCAA Student Number and their personal 
details record is, therefore, incomplete. 

• Students must be moved from the Import Hold Table and allocated a VCAA Student Number before they 
can be enrolled in a program.  

https://www.vcaa.vic.edu.au/Footer/Pages/Copyright.aspx
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Importing Student Programs 

General Principles 
VCE, VET and VPC programs can be imported into VASS. The Import Programs file structure is outlined in 
Table 2. 

VCE, VET and VPC programs can only be imported for home school students; however, the import file can 
contain enrolments for home school students assessed by other schools. 

• All students in the Import Programs file must have a year record for the current year (personal details 
already recorded). 

• Enrolments for students still on the Import Hold table will be rejected. 

VCE programs must be set up for the year before a programs import can occur: 

• This involves the selection of the VCE units that will be taught at the home school and the creation of 
classes for those units. 

• If any units taught by assessing schools are included in the file then these units must have been selected 
by the assessing schools concerned. 

• Any enrolments in the file for units not selected by either the home or assessing school will be rejected. 

VET certificates, RTOs and the assessing groups for those certificates must be selected: 

• Classes must be created for the UoCs in the stream. 

• The same class code must be allocated to every class in the stream. 

VPC certificates and units must be selected: 

• Providers allocated to those certificates and units. 

• Classes must be created for the VPC units. 

• Students must be already enrolled in the VPC certificate prior to importing their program 

If classes are not set up in VASS and class codes are included in the import file then the import line will be 
rejected. 
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Preparing The Import Programs File 
The Import Programs file must contain: 

• Either the DET School code of the VCAA School code. Both may be included. 

• Either the VCAA Student Number or the External Student Indentifier. Both may be included, however the 
External Student Identifier can only be used if it already exists on VASS. 

The Import Programs file can contain units for one or both semesters. 

• If the import file contains a valid VCE Unit 3 enrolment, VASS will automatically enrol the student in the 
equivalent VCE Unit 4 regardless of whether the file contains the VCE Unit 4 record. 

• An option in the Run Import screen also allows you to automatically enrol students in VCE Unit 2 classes 
based on their Unit 1 enrolments, provided the Unit 2 classes are already set up with the same class 
code as Unit 1 

Once a student’s program has been entered into VASS it is not possible to use a later import to change any 
existing enrolments, however additional enrolments may be added. 

An Import Programs file must contain one record (line) for every unit the student is enrolled in, i.e. a student 
with 7 enrolments will have 7 lines in the import file. 

Additional Field Information 

DET School Code (Column A) 

Including the DET School code is not mandatory provided the VCAA School code is included, however 
including this field will preserve the first column when modifying the file in Excel, and hence the required file 
format. 

Focus Area (Column L) 

Most studies only require the first eleven of the twelve fields in the Import Programs file. The twelfth field, 
focus area, is only used for a small number of VCE studies or to record VET certificate type (VE1, VE2 or 
VE3). 

The following VCE studies have focus areas: 

• MC04 – Music Repertoire Performance Unit 3-4 

• MC06 – Music Contemporary Performance Unit 3-4 

• TT03 – Text and Traditions Unit 3-4 

Focus area codes must be included in the Import Programs file for these studies. Any enrolments in these 
studies will be rejected if a focus code is not included in the import file. 

A summary of focus area codes is included in Table 3. 
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Table 2 – The Import Programs file structure 

Field Max Length Details 

DET School Code (Column A) 10 characters Mandatory if VCAA School Code is blank. Must be a valid DET 
School Code and match the login school 

Can be found on the SCHOOL ADMIN > Modify School Details 
screen of VASS. 

 Excel Tip: Mark as text in Excel to preserve the leading zero 

VCAA School Code (Column B) 5 characters Mandatory if DET School Code is blank. 

Can be found on the SCHOOL ADMIN > Modify School Details 
screen of VASS. 

 Excel Tip: Mark as text in Excel to preserve the leading zero 

VCAA Student Number (Column C) 9 characters Mandatory if External Student Identifier is blank. 
Alphanumeric. If entered it must be a valid VCAA Student 
Number 

External Student Identifier (Column D) 12 characters Mandatory if VCAA Student Number is blank. Alphanumeric. 
If used it must already be on the VCAA database 

Family Name (Column E) 25 characters Mandatory. Can only contain letters, hyphen, apostrophes 
and single spaces. Must contain at least one character 

First Name (Column F) 15 characters Mandatory. Can only contain letters, hyphen, apostrophes 
and single spaces. Must contain at least one character 

Second Name (Column G) 15 characters Optional. Can only contain letters, hyphen, apostrophes and 
single spaces 

Unit Code (Column H) 15 characters Mandatory. Must be a valid VCE or VPC unit code or VET 
certificate code 

Class Code (Column I) 2 characters Mandatory 

DET Assessing School Code or Provider 
Code (Column J) 

10 characters Mandatory if VCAA Assessing School Code is blank. 

The Certificate Provider code can be found in the Add/Modify 
RTO screen in VASS 

 Excel Tip Mark as text in Excel to preserve the leading zero 

VCAA Assessing School Code or 
Provider Code (Column K) 

5 characters Mandatory if DET Assessing School Code is blank. 

The Certificate Provider code can be found in the Add/Modify 
RTO screen in VASS 

 Excel Tip Mark as text in Excel to preserve the leading zero 

Focus Area or VET Certificate type 
(Column L) 

3 characters Focus area codes are mandatory for MC04, MC06 and TT03 

Certificate type can be VE1, VE2 or VE3 
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Table 3 – Focus area codes 

Unit Code Title Focus Area Code 

TT03 Text and Traditions John’s Gospal TJ 

  Luke’s Gospal TL 

  Old Testament TO 

  Qur’an TQ 

MC04 Music Repertoire Performance Ensemble Performance EN 

and  Solo – Acoustic Guitar GA 

MC06 Music Contemporary Performance Solo – Alternative Instrument VCAA approved AA 

  Solo – Bassoon BS 

  Solo – Clarinet CL 

  Solo – Double Bass BD 

  Solo – Drumkit DK 

  Solo – Electric Bass BE 

  Solo – Electric Guitar GE 

  Solo – Euphonium EU 

  Solo – Fute FL 

  Solo – French Horn FH 

  Solo – Oboe OB 

  Solo – Percussion PE 

  Solo – Pianoforte PF 

  Solo – Saxophone SA 

  Solo – Trombone TB 

  Solo – Trumpet TR 

  Solo – Tuba TU 

  Solo – Viola VA 

  Solo – Violin VN 

  Solo – Violincello VC 

  Solo – Voice VO 
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Initiating a New Import 
An import can be initiated at any time of the year prior to the appropriate cut-off dates. 

• Student personal details can be imported up until the last day to amend student personal details and 
consents 

• After this date, the [Run New Import] button is not accessible. 

The imports screen contains details of all import files initiated within the past two weeks. Import files are 
ordered by the date and time of the import with the most recent listed first. 

All three import types have a validation phase followed by an update phase, provided the file structure 
meets the requirements detailed above. If the file does not match the required structure then it will be 
declared a ‘Bad File’ and will not be updated. 

 

 
Figure 2: The Import Students flow chart 
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Figure 3: The Amend Students Import flow chart 

 
 

 
Figure 4: The Import Programs flow chart 
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New Import Process 

Stage 1 – Validating the File 
1. Go to STUDENT ADMIN > Student Imports and click [Run New Import]. A dialog box will appear (see 

Figure 5) 
 

 
Figure 5: The Run Import screen 

 

2. Click [Browse] and locate the required import (*.txt) file. Select the file and click [Open]. The dialog box 
will now display the path and filename of the import file (see Figure 6) 
 

 
Figure 6: The Run Import screen containing the path and filename of the import file 

 

3. If the purpose of the file is to import new sudent personal details, select [Import Students]. A dialox box 
will ask to confirm the import (see Figure 7) 
 

 
Figure 7: The Import Students confirmation message 
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4. If the purpose of the file is to amend existing student personal details, click [Amend Students]. A dialog 
box will ask to confirm the import (see Figure 8) 
 

 
Figure 8: The Amend Students confirmation message 

 

5. If the purpose of the file is to import student programs, click [Import Programs]. A dialog box will ask to 
confirm the import (see Figure 9) 
 

 
Figure 9: The Import Programs confirmation message 

 

6. If the year, path name and file name are correct in the confirmation message, click [Yes]. The file will be 
scheduled for import and a second confirmation message will be displayed (see Figure 10). 
 

 
Figure 10: The successfully scheduled message 

 

7. Click [OK] to return to the Imports screen. The Import screen will be refreshed with details of the status 
(see Figure 11). 
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Figure 11: The Import screen with a file status of ‘Scheduled’ 

  

 The Import Type column indicates that this is a validation run. The file will be checked for the accuracy 
and completeness of the file. At this stage no data will be loaded to the VCAA database. 

 If it passes the validation step, the status will move from ‘Scheduled’, to ‘In Progress’, to ‘Validated but 
not updated (see Figure 12). Click [Recheck Status] to refresh the status. 

 

 
Figure 12: The Import screen with a file status of ‘Validated but not updated’ 
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Stage 2 – Update the Database 
1. Select the import file, then click [View Import Report]. This will produce an import report. If the report 

indicates that the import file contains an insignificant number of non-fatal errors, click [Update Student 
Details] to initiate updating the database. (see Figure 13) 
 

 
Figure 13: The Import Report for a ‘Validate Student’ import displaying the [Update Student Details] button 

 

2. A dialog box will be displayed to confirm the update of students to the VCAA database (see Figure 14) 
 

 
Figure 14: The Update Students confirmation message 

 

3. To update the data, click [Yes]. The file will be scheduled for import and a second confirmation message 
will be displayed (see Figure 15) 
 

 
Figure 15: The successfully scheduled confirmation message 
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4. Click [OK] to return to the Import screen. The Import screen with be refreshed with the details of the 
scheduled import 
 

Once the second stage of the import has commenced the import type will change to ‘Students’ or ‘Student 
Amendments’ or ‘Student Programs’ with a status of ‘Scheduled’. The file status will move from 
‘Scheduled’, to ‘In Progress’, to ‘Complete’. Click [Recheck Status] to refresh. 

 

Once an Import Students import has a status of ‘Complete’, the file has been fully processed. There are three 
possible outcomes for individual records in the file: 

• Student records are loaded to the VCAA database 

• Student records are placed on the Import Hold Table 

• Student records are rejected 

Once an Amend Students or Import Programs import has a status of ‘Complete’, the file has been fully 
processed. There are two possible outcomes for individual records in the file: 

• Student records are loaded to the VCAA database 

• Student records are rejected 

Bad Files 
If the format of the file does not match the VCAA requirements or there are too many errors in the file, the file 
will be declared a ‘Bad File’. The status is updated to read ‘Bad file so not updated’ (see Figure 16). 

 
Figure 16: The Import screen with a file status of ‘Bad file so not updated’ 

 

The most common causes for a ‘Bad File’ are: 

• The incorrect ‘import type’ button is selected 

• The file not a text (Tab delimated)(*.txt) file 

• The file has a header row 

• The import file contains a blank line 

• Invalid dates of birth (e.g. American format or 29 February in a non-Leap year) 

The Import Report must be read to determine the reason for the bad file status. Errors in the file need to be 
corrected before the file can be re-imported. 
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The validation process will stop at the line that causes the ‘Bad File’ status. A message is displayed 
at the top of the Import Report indicating the reason for the bad file and directing the user to the last 
line of the body of the report (see Figure 17). 

 
Figure 17: The Import Report for a file with a bad file status 

 

It is important to note that the bad file status is declared at the first occurrence of a problem. Check the entire 
file for similar errors before re-importing. 

The Import Report 
An import report is created following the completion of each stage of an import, and must be viewed after the 
validation stage to proceed to the update stage of the import process. 

The body of the import report displays the line number and description of all records that already exist, 
those with errors, and those resulting in Import Hold students. 

At the bottom of the report is a count of the total number of records in the file plus information on the 
number of records: 

• That were successfully loaded 

• That already exist in the current year 

• With errors 

• Resulting in import hold students. 

These counts are given for both the ‘validation’ and ‘update’ stages of the import report. The difference 
between the two is the statement appended to the bottom of the ‘Validation’ version: “These counts are what 
would apply for an Update Students run.” This statement indicates that the students have not yet been loaded 
onto the VCAA database. 

The sample in Figure 13 indicates that following the validate students run, 8 students will be loaded on to the 
VCAA database and 3 students will be placed on the Import Hold table as they match existing students on 3 of 
the 4 matching criteria. No students in this sample will be rejected due to errors. 

If the file has been declared a ‘Bad File’ then the import report will state the reason for this status. Any errors in 
the import file must be corrected before further attempts can be made to import data into VASS. 
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The Import Hold Table and Pending Students 
Following an Import Students import, incoming students may be placed on the import hold table if: 

• The student has been matched on three of the four matching criteria (family name, first name, date of birth 
and gender) to one or more students already on the VCAA database. 

• There is a mismatch between the student’s suburb and postcode. 

• There is no number in the first line of the student’s address. 

Students placed on the import hold table have an Import status, that is, they are not issued a VCAA student 
number and their personal details record is, therefore, incomplete. 

• Students must be moved from the import hold table and allocated a VCAA student number before they 
can be enrolled in a program. 

Students may be given a Pending status if their match existing students on 3 out of the 4 matching criteria. 
These students are placed on the pending table. 

• It is not possible to import personal details data or programs for a group of students if any of the students 
in the file is on the import hold or pending tables. 

• Once all valid student records on either the import hold table or the pending table have been allocated a 
VCAA student number, any records remaining should be deleted. 

Processing Import Hold Table and Pending Students 
1. Go to STUDENT ADMIN > Modify Student Personal Details 
2. Type the word IMPORT into the Student Number field and click [Find]. A list of all students on the import 

hold table will be displayed (see Figure 18) 
 

 
Figure 18: Retrieving import hold table students 
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3. To move students off the import hold table, highlight the first student on the list and click [Modify]. The 
student’s personal details will be displayed (see Figure 19) 

 

 
Figure 19: Part of the Student details screen for an import hold table student 

 

The reason for the student’s pending status is displayed under External Student ID field. In Figure 22 the 
student has been matched on 3 of the 4 matching criteria to another student who already exists in the 
VCAA database. 

A student who has been matched on 3 of the 4 matching criteria to existing students may also have 
problems with their address details. In cases where there is more than one reason for the students to be 
placed on the import hold table, only the matching reason will be given. Therefore, it may be necessary to 
correct the student’s address details before proceeding. 

4. If there is a problem with the student’s address details and this is not rectified before [Save] is selected, 
then a dialog box will appear (see Figure 20) 

 

 
Figure 20: Warning message that the postcode and suburb/town combination in the import file do not 

match the Australia Post data used by VASS 

 

To correct the address details, click [No] and make the necessary changes to the student’s address 
details. Move the student off the import hold table by clicking [Save]. 
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5. If the student has been matched against one or more existing students on the VCAA database, a student 
search results – webpage dialog box will appear. This box displays the details of existing student/s 
matching the new student’s details on 3 of the 4 matching criteria (see Figure 21) 

 

 
Figure 21: Student Search Results – Webpage Dialog box showing a student matched on 3 of the 4 matching criteria 

 

There are four possible actions: 

• If the new student is not one of those listed in the student search results dialog box, click [Save as 
New Student]. The student will be added to the VCAA database and allocated a VCAA student 
number.  

• If the new student is one of those listed in the student search results box as existing on the VCAA 
database without a record for the current year at any school, click [OK] to match the incoming record 
with the existing record. This action should only be performed if you are certain the incoming record 
matches the existing record. 

• If the new student is already at another school in the current year, click on the school name hyperlink 
to request a transfer to your school. 

• If the new student is already on the VCAA database for the login year at your school, close the match 
list by clicking [Cancel] and delete the import hold record using [Delete Student with pending 
Student Number]. The record will be deleted and the next student on the import hold table will be 
displayed 
 

 Click [Next >>] to move to subsequent students on the import hold table. 
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Import Error Messages 

Import and Amend Students Error Messages 
The error messages in Table 4 may occur when student personal details are imported into VASS. Errors 
designated fatal errors will cause the entire file to be deemed a bad file and stop the import. 

• Any non-fatal errors will cause the record to be rejected and the program will then attempt to load the next 
record in the file. Some errors will result in warning messages rather than errors. 

• Unless indicated otherwise, the errors apply to both Import Students and Amend Students imports. 

• The Import Report lists the number of records successfully processed, as well as any errors. The rejected 
records may be corrected and the import process attempted again. 

 

Table 4 – Summary of import and amend student error messages 

Field Import Type Error Type Error / Warning Message 

Course Type  Fatal Course type is greater than 3 character 

  Non-fatal Invalid course type for login year 

  Non-fatal PDO student matched to a non PDO student 

DET School Code  Fatal DET school code is greater than 10 character 

  Non-fatal DET school code does not match current school 

VCAA School Code  Fatal VCAA school code is greater than 5 characters 

  Non-fatal VCAA school code does not match current school 

Student Number  Fatal Student number is greater than 9 characters 

  Non-fatal Student number can onl contain alphanumeric characters 

  Non-fatal Invalid Student number 

 Import Non-fatal Student already exists for current year 

 Amend Non-fatal Student doesn’t exist for current year 

External Student Identifier Import Non-fatal External student identifier is greater than 12 characters 

 Import Non-fatal External student identifier belongs to another student, will 
be loaded as blank 

 Amend Fatal Either Student Number or External Student Identifier must 
be entered 

 Amend Non-fatal External student identifier belongs to another student 

 Amend Non-fatal External student doesn’t uniquely identify a student 

 Amend Non-fatal External student identifier is different to that stored on the 
VCAA database 
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Field Import Type Error Type Error / Warning Message 

Family Name  Fatal Family name is greater than 25 characters 

  Non-fatal Family name contains invalid characters 

First Name  Fatal First name is greater than 15 characters 

  Non-fatal First name contains invalid characters 

Second Name  Fatal Second name is greater than 15 characters 

  Non-fatal Second name contains invalid characters 

Email  Non-fatal Email contains more than one “@” symbol, spaces or 
special characters.   

Address Line 1  Fatal Address Line 1 is greater than 25 characters 

  Non-fatal Address Line 1 must contain at least one numeric character 

Address Line 2  Fatal Address Line 2 is greater than 25 characters 

Suburb  Fatal Suburb is greater than 30 characters 

State / Country  Fatal State / Country is greater than 17 characters 

  Non-fatal Invalid State / Country 

Postcode  Fatal Postcode is greater than 4 characters 

  Non-fatal Invalid postcode 

Telephone Number   No error statements 

Date of Birth  Fatal Date of birth entered in incorrect format or contains 
characters 

  Fatal Invalid date of birth 

  Non-fatal Date of birth must not be greater than the current year 

  Non-fatal Student is less than 11 y.o. or greater than 80 y.o. 

Gender  Fatal Gender must only be ‘F’, ‘M’ or ‘X’ 

Year Level  Fatal Year level must be a number between 7 and 12 

Home Group  Non-fatal Form group is greater than 8 characters 

  Non-fatal Form group contains non-alphanumeric characters 

Previous Family Name  Fatal Previous family name is greater than 25 characters 

  Non-fatal Previous family name contains invalid characters 

Previous First Name  Fatal Previous first name is greater than 15 characters 

  Non-fatal Previous first name contains invalid characters 
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Field Import Type Error Type Error / Warning Message 

Previous Second Name  Fatal Previous second name is greater than 15 characters 

  Non-fatal Previous second name contains invalid characters 

General Declaration  Fatal General declaration flag must be either ‘Y’ or ‘N’ 

  Fatal Student has not signed general declaration 

Victorian Student Number  Fatal Victorian Student Number is not a valid VSN 

   Victorian Student Number is greater than 9 digits 

Import Programs Error Messages 
The error messages in Table 5 may occur when student programs are imported into VASS. Errors designated 
fatal errors will cause the entire file to be deemed a bad file and will stop the import. 

• Any non-fatal errors will cause the record to be rejected and the program will then attempt to load the next 
record in the file. 

• The Import Report lists the number of records successfully processed, as well as any errors. The rejected 
records may be corrected and the import process attempted again. 

 

Table 5 – Summary of import programs error messages  

Field Error Type Error / Warning Message 

DET School Code Fatal DET school code is greater than 10 character 

 Non-fatal DET school code does not match current school 

VCAA School Code Fatal VCAA school code is greater than 5 characters 

 Non-fatal VCAA school code does not match current school 

Student Number Fatal Student number is greater than 9 characters 

 Non-fatal Student number can onl contain alphanumeric characters 

 Non-fatal Invalid Student number 

 Non-fatal Student is registered at another home school 

 Non-fatal Student is not registered for the current year 

External Student Identifier Fatal External student identifier is greater than 12 characters 

 Non-fatal Student is not registered for the current year with the given 
external student identifier 

 Non-fatal Student has been matched to more than one existing student 
by External Student Identifier 
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Field Error Type Error / Warning Message 

Family Name Fatal Family name is greater than 25 characters 

 Non-fatal Family name contains invalid characters 

 Non-fatal Family name does not match VCAA database 

First Name Fatal First name is greater than 15 characters 

 Non-fatal First name contains invalid characters 

 Non-fatal First name does not match VCAA database 

Second Name Fatal Second name is greater than 15 characters 

 Non-fatal Second name contains invalid characters 

 Non-fatal Second name does not match VCAA database 

Unit Code Fatal Unit Code is greaer than 15 charcters 

 Non-fatal Invalid unit code for login year 

 Non-fatal Invalid VCAA VET Certificate code for login year 

 Non-fatal Cannot enrol in both English and EAL 

 Non-fatal Student not approved to enrol in EAL 

 Non-fatal Student not approved to enrol in Second Language 

 Non-fatal Cannot enrol in First and Second Language streams 

 Non-fatal Cannot enrol in First Language as approved for Second 
Language 

 Non-fatal Student enrolled in unit at another school 

 Non-fatal Student enrolled in unit in a different class 

 Non-fatal Student enrolled in unit with a different focus area 

 Non-fatal Enrolment already exists for login year 

Class Code Fatal Class code is greater than 2 characters 

 Fatal Invalid class code for login year 

 Non-fatal Past enrolment cut-off date for semester 

DET Assessing School Code Fatal DET assessing school code is greater than 10 characters 

 Fatal Both DET Assessing School Code and VCAA Assessing 
School code are blank 

 Non-fatal Unit not is assessing school program 
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Field Error Type Error / Warning Message 

VCAA Assessing School Code Fatal VCAA Assessing School Code is greater than 5 characters 

 Fatal Both VCAA Assessing School code and DET Assessing 
School Code are blank 

 Non-fatal Unit not in assessing school program 

Focus Area Fatal Focus area is greater than 3 characters 

 Fatal Mandatory if VET certificate is being imported 

 Non-fatal Unit does not require focus area 

 Non-fatal Unit requires focus area 

 Non-fatal Not a valid focus area for the unit 
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Student Personal Details Forms and Consent Flags 
All students must complete the appropriate Student Personal Details Form at the beginning of each 
academic year. 

Students can give consent to the following permissions stored on VASS: 

• Media Release – the student agrees to the publication of their name and school to the media if they 
achieve a study score of 40 or greater. 

• Awards Processing – the student agrees to the release of their personal details to relevant Government 
Departments for the selection of students for the Premier’s VCE Awards and the Australian Students Prize 
or VPC Awards. 

• On Track Release – releases a student’s name and contact information to DET so that the student can be 
invited to participate in the On Track project. 

• Copyright (permission for use of student work) – grants permission to the VCAA to use any materials 
produced in the course of assessment for the VCE in publications or productions approved by the VCAA. 

When students are registered on VASS the four consent / permission flags must be set to either ‘Yes’ or ‘No’. 
They cannot be left blank. Due to privacy legislation neither the school nor the VCAA can assume that 
students will agree to these consents. 

When student records are rolled over from one year to another, the four consent / permission flags are 
automatically reset to ‘No’. Importing student details into VASS also sets these four consent flags to ‘No’. 
These flags must manually be amended annually according to the students’ wishes as indicated on the signed 
student personal details forms. 

The consequences of leaving the flags set to ‘No’ are: 

• The student’s name will not appear in the media if they have a study score of 40 or greater 

• The student’s name wil not be released to DET for the purpose of the On Track project 

If there are a large number of consent flags set to ‘No’ at a particular school this will result in a low 
participation rate for the On Track project for that school and the possible non publication of the school’s 
results/data. 

Once a student’s record has been created on the VCAA database and the consent flags set as indicated by 
the student, subsequent imports of the student’s personal details will not alter the consent flags. 

It is the responsibility of the VASS Administrator in each school to ensure that each student’s consent flags 
correctly reflect the choice authorised by each student on their personal details form. This is particularly 
important for Year 12 students and other students undertaking a Unit 3-4 study. 

Students must have access to a copy of the VCAA Collection Notice for VCE and VPC Students which 
outlines the use and disclosure of student data to other organisations before they are asked to complete their 
student personal details forms. 
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Modifying Import Files in Excel 
Student personal details and program information is often extracted from student management systems, which 
may not be exported in the correct file format. Modifying these extracts file in Excel provides an opportunity to 
check the files for structural errors or missing data. 

Start by opening a blank Microsoft Excel workbook. 

6. Select File > Open 
7. Browse to locate your .txt file. Ensure All files (*.*) is selected from the File Name drop down field 
8. Select the required .txt file and click [Open]. This should open the file using the Text Import Wizard. 
9. Text Import Wizard – Step 1 of 3: Check the ‘Delimited’ option and click [Next] 
10. Text Import Wizard – Step 2 of 3: Check the ‘Other’ option and enter a pipe ‘|’ symbol into the ‘Other’ 

field. Click [Next] 
11. Text Import Wizard – Step 3 of 3: Mark any fields that may contain a leading zero or a date as ‘text’ to 

preserve the format. Click [Finish] 
12. Select File > Save As to save the file as a Text (Tab delimited)(*.txt) file 
 
 

 
Figure 22: The Text Import Wizard – Step 1 of 3 

 
Figure 23: The Text Import Wizard – Step 2 of 3 

 

 
Figure 24a: The Text Import Wizard – Step 3 of 3 

 

 
Figure 24b: The pipe ‘|’ character on the keyboard 
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Extracting Data from VASS 
Many VASS reports allow data to be extracted as a (*.vass) file. Once converted to a more usable format, the 
extracted files can be imported into other reporting or timetabling packages. 

Student Enrolments 
If Unit 1 enrolments were originally entered without the corresponding Unit 2 enrolments then it is possible to 
extract the semester one enrolments. 

The extracted file can then be modified using Microsoft Excel to meet the Import Programs file structure and 
update the Unit 1 studies to Unit 2. Saved as a tab delimited file, the data can then be imported into VASS. 

The following points outline the steps required to extract class list data from VASS: 

1. Go to STUDENT PROGRAM > VCE Reports > Class Lists 
2. Set Semester to ‘1’ and Unit Level to ‘1,2’ 
3. Change the Report Type to ‘Export detailed list’ 
4. Click [Run VCE Class List Report]. A popup will ask you to confirm the generation of this report – click 

[Yes] 
5. The file downloaded dialog box will appear. Click on the arrow next to the ‘Save’ options and select ‘Save 

As’ to save the file in a specific location 

Examination Centre Summary 
The student number and name of every student who is flagged to sit particular written examination is already 
in VASS. This information can be extracted and used to created seating plans or attendance lists for end of 
year examinations. 

1. Go to STUDENT PROGRAM > VCE Reports > Examination Centre Summary 
2. Selet the Cycle and Study which automatically selects the Graded Assessment 
3. Check ‘Yes’ for Include Student Details 
4. Select ‘No’ for Include home school students sitting at other centres 
5. Change the Report Type to ‘Export list’ 
6. Click [Run Examination Centre Summary] 
7. The file download dialog box will appear. Click on arrow next to the ‘Save’ options and select ‘Save As’ to 

save the file in a specific location 
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Converting a (*.VASS) file 
Open a blank Microsoft Excel workbook. 

1. Select File > Open 
2. When searching for your file, ensure the file type is changed to All Files (*.*). Select your file and click 

[Open] 
3. Text Import Wizard – Step 1 of 3: Check the ‘Delimited’ option and click [Next] 
4. Text Import Wizard – Step 2 of 3: Check the ‘Other’ option and enter a pipe ‘|’ symbol into the ‘Other’ 

field. Click [Next] 
5. Text Import Wizard – Step 3 of 3: Mark any fields that may contain a leading zero or a date as ‘text’ to 

preserve the format. Click [Finish]. 
6. The file can now be saved in Excel format for ease of use 

Extracting Data from CASES21 
Government schools can extract students’ personal details and program data from CASES21. The files 
created by CASES21 for VASS are pipe delimited test files. 

CASES21 has three extracts designed for VASS: 

• For students undertaking a VCE, VPC or VET program use Export VASS Student Details. The course 
code in this file is VCE 

• For Year 10 students who are being entered onto VASS for the purpose of the On Track Proect use the 
Year 10 On Track Export for VASS. The course code in this file is PDO. Once students have been 
imported into VASS the course code may be changed for any Year 10 students undertaking a senior 
secondary program 

• To extract VCE student programs use Export VASS Student Programs. This export is only useful if 
timetabling information has been entered into CASES21 

Extracting Personal Details 
1. Log into CASES21 and select the menu STUDENT > Export/Import Data > VASS 
2. From the VASS menu open the Export VASS Student details menu item (for students undertaking a 

senior secondary program) or the Year 10 On Track Export for VASS (for Year 10 students entered on 
VASS as part of the On Track project). The parameters for Export VASS Student Details dialog box will 
open. 

3. To enter the From Year Level value, click on the down arrow and a Choose from Year Levels dialog 
box will appear. Select the required year level and click [OK]  to return to the parameters dialog box 

4. The To Year Level may be the same as or greater than the From Year Level. If the same year level is 
selected in both fields, then the resulting file will only contain a single year level. 

5. Enter the VCAA school code (5 numeric characters) in the Enter Your VCAA Code field. The VCAA 
school code can be found using the VASS menu: SCHOOL ADMIN > Modify School Details screen. The 
VCAA school code is not a mandatory field.  

6. When all the required data has been entered in the parameters dialog box, click [OK] and an Export to 
dialog box will appear 
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7. Select the location you wish to save the file. The default name for the file is STXXXXXX.txt. Change this 
to an appropriate name and ensure the file type is a Text (Tab delimited) (*.txt) file before selecting 
[Save]. 

8. A confirmation box will be displayed stating the number of records exported. Click [Confirm & Close]. 
You may now exit CASES21 

Import Summary 
Table 6 and Table 7 sets out the steps required to successfully import a student personal details and program 
data file into VASS, and how to troubleshoot any problems that may occur. 

Table 6 – Import student personal details summary 

Step Student Personal Details Import Comment 

1 Create the data file 

 

Extract student personal details data from your school’s student 
management system as a pipe or tab delimited test file. Ensure the file 
meets the required file structure. 

For further details see: 

Preparing The Import Students File 

Extracting Data from CASES21 

Modifying Import Files in Excel 

ACTION: Prepare a file containing the student personal details 

2 Initiate a New Import Initiate a new Import Students import using STUDENT ADMIN > Student 
Imports. 

For further details see: 

Initiating a New Import 

ACTION: Run new import 

3 Check the progress of the import Check the progress of the import and its position in the list of scheduled 
jobs. 

For further details see: 

Stage 1 – Validating the File 

ACTION:  Check the progress of the import 

4 View the Import Report At the end of the first stage of the Import Students import it is necessary 
to view the import report before you can proceed to the second stage of 
the process. 

For further details see: 

The Import Report 

ACTION: View the import report 
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Step Student Personal Details Import Comment 

5a Update Students If the file status is ‘Validated but not Updated’ then the first stage of the 
import has been successful and the import can be progressed 

For further details see: 

Stage 2 – Update the Database 

ACTION: Complete the import by clicking the [Update Students] button 
available within the import report. 

5b Bad File If the file status in ‘Bad File so not Updated’ then the import report must be 
read to determine the reason for the failure of the import, 

For further details see: 

Bad Files 

Import and Amend Students Error Messages 

ACTION: Read the import report to determine the reason for the bad file 
status 

6a Check the progress of the file Check the progress of the second stage of the import and its position in 
the list of scheduled jobs.  

ACTION: Check the progress of the import 

6b Correct the data in the file and return to 
Step 2 

If the status is ‘Bad File so not Updated’ then appropriate changes must be 
made to the data (either to the actual data source or to the import file) as 
outlined in the import report. The import must then be recommenced. 

For further details see: 

Modifying Import Files in Excel 

ACTION: Correct data and restart the import process 

7 View the final Import Report At the end of the second stage of the Import Students import it is 
necessary to revist the import report. The report will list any students 
placed on the Import Hold table and any rejected student records. 

For further details see: 

The Import Report 

ACTION: Review the final Import Report 

8 Resolve Import Hold students Students placed on the import hold table must be allocated a student 
number before their program can be entered. 

For further details see: 

The Import Hold Table and Pending Students 

ACTION: Process any students on the Import Hold table and correct any 
data for rejected students 
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Table 7 – Import student programs summary 

Step Student Programs Import Comment 

1 Create the data file Extract student program data from your school’s timetable program as a 
pipe of tab delimited text file. Ensure the file has been configured correctly 
for import. 

For further details see: 

Preparing The Import Programs File 

Modifying Import Files in Excel 

ACTION: Prepare a file containing student programs 

2 Initiate a new import Initiate a new Import Programs import using the menu STUDENT ADMIN 
> Student Imports 

For further details see: 

Initiating a New Import 

ACTION: Run a new import  

3 Check the progress of the import Check the progress of the import and its position in the list of scheduled 
jobs. 

For further details see: 

Stage 1 – Validating the File 

ACTION:  Check the progress of the import 

4 View the Import Report At the end of the first stage of the Import Students import it is necessary 
to view the import report before you can proceed to the second stage of 
the process. 

For further details see: 

The Import Report 

ACTION: View the import report 

5a Update Programs If the file status is ‘Validated but not Updated’ then the first stage of the 
import has been successful and the import can be progressed 

For further details see: 

Stage 2 – Update the Database 

ACTION: Complete the import by clicking the [Update Programs] button 
available within the import report. 

5b Bad File If the file status in ‘Bad File so not Updated’ then the import report must be 
read to determine the reason for the failure of the import, 

For further details see: 

Bad Files 

Import Programs Error Messages 

ACTION: Read the import report to determine the reason for the bad file 
status 
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Step Student Programs Import Comment 

6a Check the progress of the file Check the progress of the second stage of the import and its position in 
the list of scheduled jobs.  

ACTION: Check the progress of the import 

6b Correct the data in the file and return to 
Step 2 

If the status is ‘Bad File so not Updated’ then appropriate changes must be 
made to the data (either to the actual data source or to the import file) as 
outlined in the import report. The import must then be recommenced. 

For further details see: 

Modifying Import Files in Excel 

ACTION: Correct data and restart the import process 

7 View the final Import Report At the end of the second stage of the Student Programs import it is 
necessary to revist the import report. The report will list any rejected 
records.  

For further details see: 

The Import Report 

ACTION: Review the final Import Report 

8 Follow up tasks Once student programs have been entered, Student Full Details report 
should be printed and distributed to students for checking and subsequent 
modifications made on VASS 

ACTION: Print and distribute Student Full Details reports. Collect signed 
reports and make any necessary alternations to personal details or 
programs. File signed copies of the reports. 
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